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Distribution and reprinting of this document, use and communication of its 
contents is not permitted without written authorisation from Vitrolife GmbH. 	
This user manual covers both the usage of the static LaserShot M and the 
NaviLase. Sections referring to dynamic laser system NaviLase are explicitly 
intended for users of this system.

You may copy this for internal use only, not for publishing. 

The Vitrolife logotype is a trademark of Vitrolife Sweden AB, registered in 
Europe, the U.S. and other countries.
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For the sake of convenience the Octax LaserShot or Octax NaviLase will be 
referred to as LaserShot or NaviLase in this user manual.
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Intended Use for Octax LaserShot M and NaviLase

For use in assisted reproduction procedures to ablate or drill the zona pellucida of an oocyte or embryo 

to facilitate assisted hatching or recovery of cells for pre-implantation genetic diagnosis. The device can 

also be used on blastocyst stage embryos for biopsy of trophectoderm cells for pre-implantation diagnosis 

procedures, blastocyst collapse prior to vitrification procedures and sperm viability testing.

Intended Purpose Octax LaserShot M and NaviLase

Octax LaserShot M and Octax NaviLase are laser systems dedicated to be used in clinical routine in the field 

of assissted reproductive technology (ART). The laser systems are part of assissted reproduction procedures 

to ablate or drill the zona pellucida of an oocyte or embryo to facilitate asssisted hatching or recovery of cells 

(polar bodies or blastomeres or trophectoderm cells) for pre-implantation genetic diagnosis, respectively. 

The devices can also be used to collapse blastocyst stage embryos prior to vitrification and to identify viable 

spermatozoa among immotile spermatozoa.

Contraindications for Octax LaserShot M and NaviLase

At present there are no known cell-specific contraindications, i.e. there are no morphological or other cell 

indicators for oocytes, embryos ans sperm cells, that are contraindications for using the Octax LaserShot M 

and NaviLase System. Contraindications on the patient side regarding Assisted Hatching or biopsy of oocytes 

or embryos are left to the judgement of the physician and are related to the patient or the number of oocytes 

or embryos available. There are no patient-related contraindications for sperm viability testing. The Octax 

LaserShot M and NaviLase System does not have any influence on treatment related contraindications.

Side effects Octax LaserShot M and NaviLase System

When using the laser systems not according to their intended use, there is a risk of partial damage in the 

cytoplasm due to heat and degeneration of the cell treated. This is especially the case when the laser beam 

is directly focussed or applied to a cell. When using the NaviLase system in multi-pulse mode and intentional 

or unintentional movement of the oocyte or embryo treated during the application of the laser beam, there is 

a chance that the laser interacts with non-defined areas of the cells and damage to the cells. Laser energy 

which is absorbed by medium causes a temperature increase. When releasing twenty laser pulses at 10 ms 

pulse length using a 150 mW laser beam, a calculated energy of 30 mJ is transferred to the medium. In an 

isolated media droplet of 20 μl volume this amount of energy, evenly spread over the volume, would cause 

a temperature increase of 0.36°C. When using the laser systems for sperm viability testing, using the laser 

beam repeteadily and directly on the sperm head  may damage the functionality of proteins located in the 

sperm head.
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Intended user group

Healthcare professionals, typically medical technical assistants (MTA) or clinical embryologists. The user has 

to have at least basic experience in working in an IVF laboratory, especially with one or all of the procedures in 

which the use of a laser system is potentially indicated, e.g. ICSI, Assisted Hatching, Biopsy, Vitrification.

Intended patient target groups

Female and Male patients in the age group below a maternal age of 60 that have failed to achieve a clinical 

pregnancy after 12 months or more of regular unprotected sexual intercourse and / or patients with a specific 

disease or genetic predisposition in the male or female that require ART in order to enable pre-implantation 

diagnosis of the chromosomal or genetic constitution of their oocytes or embryos.

Intended clinical benefits to patients

The intended clinical benefits apply to patients who undergo a treatment in the field of assisted reproduction 

with the aim to achieve a clinical pregnancy. Ablation or drilling of the zona pellucida of an oocyte or embryo 

facilitates assisted hatching of the embryo prior implantation and can benefit the clinical outcome by better 

implantation or live brith rate. In regard to the recovery of cells (polar bodies or blastomeres or trophectoderm 

cells) for pre-implantation genetic diagnosis, the benefit of the laser is to facilitate the procedure, whereby 

reducing the time of exposure of oocytes or embryos to unfavorable culture conditions. For blastocyst 

collapse prior vitrification the application of the laser supports better survival rates after vitrification / warming, 

which increases the total number of embryos available for consecutive transfers. The identification of viable 

spermatozoa among immotile spermatozoa by the laser technqiue has a beneficial effect on fertilization rates, 

which are connected to the clinical outcome.
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This symbol denotes important information regarding the correct 
treatment of cells and the proper use of the laser. Please read all 
warnings carefully before treating any embryos or oocytes to ensure 
safe application and optimal results.

EYE SAFETY OF THE OPERATOR 

Eye safety of the operator is guaranteed under normal operation 
of the LaserShot M and NaviLase, and in a situation when user 
removable parts may be missing. However, do not disassemble 
or uninstall the LaserShot M or NaviLase system and watch the 
beam employing optics. Any installation / deinstallation of hard- and 
software, respectively, is strictly reserved to trained and certified 
service personnel authorized by Vitrolife GmbH.

This symbol denotes important cautions. Please read all 
precautions before treating any embryos or oocytes to ensure safe 
and optimal results.

This symbol denotes important additional information regarding the 
laser device and treatment of cells.

ABOUT THIS MANUAL

The procedures described in this manual concern a particular 
device installed by Vitrolife GmbH authorized personnel at a 
designated location. The LaserShot M or NaviLase devices must 
be operated by trained personnel according to the instructions 
contained in this user manual. 

LASER

The laser of the LaserShot M and the NaviLase system are 
classified as a class 1M laser. Class 1M lasers emit in the 
wavelength range from 302,5 nm to 4000 nm. 

Laser Radiation, do not view directly with optical instruments.

warnings

Definitions

To avoid the risk of electric shock, this equipment must only be 
connected to a supply mains with protective earth.
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INTEGRITY OF THE ELECTRO-OPTICAL SYSTEM

Maintenance of microscope components, wrong handling of the 
microscope or strong displacement of the electro-optical system, 
e. g. by mechanical shock can result in an incorrect position of the 
beam splitter system, the magnifier lens, the camera, and the turret, 
respectlively. As a result of any of the above, aiming of the laser may 
no longer correspond to the crosshair position displayed at the video 
image and damage to embryos may occur if the laser is used in this 
condition. After maloperation of the microscope, repeat the Laser 
aiming verification procedure or contact Technical Service.

INCORRECT LASER AIMING

Failure to follow the laser aiming verification procedure could result in 
wrongly located openings and therefore may damage the treated oocyte 
or embryo. 

MULTIPLE OR SMALL OPENINGS

Only a single opening should be made in the zona pellucida. Multiple 
openings or openings that are too small may prevent embryo hatching 
and/or lead to abnormal embryo development.

DEVELOPMENT STAGE

Laser assisted hatching should only be performed on 4-8 cell embryos. 
Effects of laser assisted hatching on embryos of later developmental 
stages (> 8 cell stage) are not known.

LONG-TERM FOLLOW UP

To date there are no known reports showing a greater occurrence 
rate of major or minor defects in children born after laser assisted 
hatching of embryos. Long-term follow-up data on children derived 
from embryos treated by laser assisted hatching does not yet exist. 
A follow-up study of 134 such babies found no increase in the major 
congenital malformations, chromosomal aberrations or minor congenital 
malformations between the laser assisted hatching treated group and 
all deliveries at their hospital. (Kanyo, K., Konc, J. “A follow-up study of 
children born after diode laser assisted hatching.” European Journal of 
Obstetrics and Gynecology. 110: 176-180 (2003)).

Only use the 25x laser lens when using LaserShot M or NaviLase. Use 
of other objectives for laser treatments may damage the embryo.
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INSTALLATION AND MAINTENANCE

Installation and repair of the LaserShot M or NaviLase shall only be 
carried out by a person certified by Vitrolife. The LaserShot M must 
remain on the microscope and at the location where it was installed. 
If a LaserShot M or NaviLase is disconnected and/or moved without 
supervision by a person certified by Vitrolife the LaserShot M or 
NaviLase will no longer be approved for clinical use and the warranty 
may be voided.

If the LaserShot M , NaviLase or parts of it are modified, appropriate 
inspection and testing must be conducted by a Vitrolife certified 
person to ensure continued safe use.

A preventative maintenance of the laser is recommended every 
12-18 months to ensure optimal performance of the laser.

ELECTROMAGNETIC COMPATIBILITY

The LaserShot M and Navilase have been tested and found to com-
ply with the limits for medical devices to the IEC 60601-1-2:2014/  
EN 60601-1-2:2014 for electromagnetic compatibility. These limits 
are designed to provide reasonable protection against harmful inter-
ference in a typical medical installation. 

This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruc-
tions, or if connected to material not certified by Vitrolife, may cause 
harmful interference to other devices in the vicinity. However, there 
is no guarantee that interference will not occur in a particular instal-
lation. If this equipment does cause harmful interference to other 
devices, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving device.

• Increase the separation between the equipment.

• Connect the equipment into an outlet on a circuit different from that 
to which the  other device(s) are connected.

Consult the manufacturer, their representative or dealer for help.

WARNING: The use of accessories and cables other than those 
supplied by Vitrolife, may result in increased emissions or decreased 
immunity of the ME equipment or ME system.

WARNING: Portable RF communications equipment (including 
peripherals such as antenna cables and external antennas) should be 
used no closer than 30 cm (12 inches) to any part of the LaserShot 
M , including cables specified by the manufacturer. Otherwise, deg-
radation of the performance of this equipment could result.
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CONNECTION TO EXTERNAL EQUIPMENT

To guarantee basic safety and compliance with elevant EC standard 
(i.e. EN 60601-1 – Part 1 for medical electrical equipment) and 
essential performance, this equipment must only be connected to 
computer equipment certified by Vitrolife, and connection must only 
be made using certified cables.

LIMITED WARRANTY

Vitrolife warrants exclusively to the Customer that for a period of 
12 months from date of installation or 13 months from date of 
shipment, whichever comers first, the LaserShot M or NaviLase will 
be free from defects in material and workmanship under normal use. 
The Customer shall notify Vitrolife of any defect that occurs during this 
period immediately after having discovered the defect and in any case 
not later than 5 days thereafter.

The limited warranty shall terminate immediately if installation, 
maintenance, repair or relocation of the laser system is carried out by 
other than Vitrolife certified personnel.

• The limited warranty shall not apply to damage resulting from:

• Failure to perform routine maintenance in accordance with this User 
Manual;

• Accident, abuse, misuse, or misapplication of the device;

• Use and operation that does not comply with instructions provided in 
the User Manual; 

• Normal wear and tear.

CONNECTORS

Do not disconnect the USB cable connector unless instructed to do 
so by qualified support personnel.

The recipient end user of the LaserShot M / NaviLase systems should 
not unpack and install it upon receipt. Unpacking, installation, setup 
and end-user training of LaserShot M / NaviLase systems must be 
carried out by appropriately qualified technical staff authorized by 
Vitrolife GmbH.

TE MODE: RESTRICTIONS IN USE

The TE mode must only be used by experienced users trained in doing 
trophectoderm biopsies. The laser puls(es) can assist the release of 
mechanically stretched intracellular bonds between trophectoderm 
cells for biopsy. The TE mode must never be applied to the zona 
pellucida.
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INFLUENCE OF Z-POSITION OF THE OOCYTE/EMBRYO ON 
DRILL OPENING SIZE

Inappropriate Z-positioning will result in smaller drill holes and in 
reduced laser beam quality. It is recommended to keep the cell near the 
bottom of the culture dish during laser treatment.

precautions

To minimize the risk of damage to the oocyte or embryos, administer 
as few laser pulses as possible at the lowest energy levels possible to 
achieve the prescribed effect.

Direct the laser beam towards a section of the zona pellucida where the 
adjacent perivitelline space is widest or next to an area of fragmentation.

A holding pipette should be used during laser treatment to minimize the 
risk of embryo movement.

REPEATED LASER SHOTS

Repeated laser shots to the same position of the embryo could result in 
an increased risk of embryo damage. In case of risk of applying repeated 
laser shots to the same position of the embryo the laser action can be 
immediately stalled by pressing the emergency stop button.

INFLUENCE OF TEMPERATURE ON DRILL OPENING SIZE

When using a heated stage during zona manipulation, make sure that 
it has been set to the correct temperature. Inappropriate temperature 
settings will lead to unexpected drill hole sizes. Lower temperatures 
result in smaller openings, while higher temperatures cause openings of 
excessive sizes that may lead to embryo damage.

The user of the laser system should report any serious incident that has 
occurred in relation to the device to Vitrolife and the competent authority 
of the Member State in which the user is established.

"Serious incident" means any incident that directly or indirectly led, 
might have led or might lead to any of the following: (a) the death of a 
patient, user or other person, (b) the temporary or permanent serious 
deterioration of a patient's, user's or other person's state of health, (c) a 
serious public health threat.
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Electromagnetic 
Compatibility (EMC)
The below table contains the applicable information required for CISPR11 systems:

Guidance and manufacturer’s declaration – Electromagnetic emissions
LaserShot M and NaviLase laser systems is intended for use in the electromagnetic environment 
specified below. The customer or the user of LaserShot M and NaviLase laser systems should 
assure that it is used in such an environment

Emissions test

RF emissions
EN/CISPR 11
Radiated and
Conducted
Emission

Harmonic emissions
IEC 61000-3-2

Voltage fluctuations
flicker emissions
IEC 61000-3-3

Compliance

Class A
Group 1

Class A

Passed

Electromagnetic environment - guidance

LaserShot M and NaviLase laser systems 
use RF energy only for their internal function. 
Therefore, their RF emissions are very low and 
not likely to cause any interference in nearby 
electronic equipment.

The emissions characteristics of this
equipment make it suitable for use in
industrial areas and professional
healthcare facility environment (CISPR 11
class A). It it is used in a residential
environment (for which CISPR 11 class B
is normally required) this equipment might
not offer adequate protection to 
radiofrequency
communication services. The
user might take mitigation measures, such
as relocating or re-orienting the equipment.
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Electromagnetic Immunity

Guidance and manufacturer’s declaration – Electromagnetic immunity
LaserShot M and NaviLase laser systems is intended for use in the electromagnetic environment specified below. The customer 
or the user of LaserShot M and NaviLase laser systems should assure that the  used in such an environment

Immunity test

Electrostatic
discharge (ESD)
IEC 61000-4-2

Electrical fast transient
/burst IEC 61000-4-4

Surge
IEC 61000-4-5

Voltage dips, short
interruptions and
voltage variations on
power supply input
lines IEC
61000-4-11

Power frequency
(50/60 Hz)
Magnetic field IEC
61000-4-8

Compliance

contact ± 8 kV
air ± 2 kV, ± 4 kV, ± 8 kV, ± 15 kV

AC Mains +/- 2kV
Signal +/- 1 kV 100 kHz repetition
frequency

Line-to-line ± 0.5 kV, ± 1 kV Line-To-Earth
± 0,5kV, ±1kV, ±2kV

0 % UT; 0,5 cycle
At 0°, 45°, 90°, 135°, 180°, 225°, 270° and 315°
0 % UT; 1 cycle
and
70 % UT; 25/30 cycles
Single phase: at 0°
and
0 % UT; 250/300 cycle

30 A/m
50 & 60 Hz

Electromagnetic 
environment - guidance

Floors should be wood, concrete or ceramic tile.
If floors are covered with synthetic material, the
relative humidity should be at least 30%

Mains power quality should be that of a typical
commercial or hospital environment

Mains power quality should be that of a typical
commercial or hospital environment

Mains power quality should be that of a typical
commercial or hospital environment
If the user of LaserShot M and NaviLase laser
systems requires continued operation during
power mains interruptions, it is recommended
that the incubator be powered from an
uninterruptible power supply or battery.
No degradation of the essential performance was
observed and EUT remains safe during the test.

Power frequency magnetic fields should be at
levels characteristic of a typical commercial or
hospital environment.
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Immunity test

Conducted RF              
IEC 61000-4-6

Radiated RF            
IEC 61000 4-3

Compliance

3 V
0,15 MHz – 80 MHz
6 V in ISM and amateur radio bands
between 0,15 MHz and 80 MHz
80 % AM at 1 kHz

3 V/m
80 MHz to 2.7 GHz

Electromagnetic 
environment - guidance

No degradation of the essential performance was
observed and EUT remains safe during the test in
normal operational mode and in alarm mode.
Portable and mobile RF communications equipment
should be used no closer to any part of LaserShot M
and NaviLase laser systems, including cables, than
the recommended separation distance calculated
from the equation applicable to the frequency of the
transmitter.

IMMUNITY to proximity fields from RF wireless
communications equipment IEC 61000-4-3
28 V/m
450 MHz, ±5 kHz FM, 1 kHz sinus
810 MHz, 50% PM at 18 Hz
870 MHz, 50% PM at 18 Hz
930 MHz, 50% PM at 18 Hz
1720 MHz, 50% PM at 217 Hz
1845 MHz, 50% PM at 217 Hz
1970 MHz, 50% PM at 217 Hz
2450 MHz, 50% PM at 217 Hz
27 V/m
385 MHz, 50% PM at 18 Hz
9 V/m
710 MHz, 50% PM at 217 Hz
745 MHz, 50% PM at 217 Hz
780 MHz, 50% PM at 217 Hz
5240 MHz, 50% PM at 217 Hz
5500 MHz, 50% PM at 217 Hz
5785 MHz, 50% PM at 217 Hz

The below two tables contain the applicable information required for a system other than those 
specified for use only in a shielded location and for systems that are not life supporting.

Guidance and manufacturer’s declaration – Electromagnetic immunity
LaserShot M and NaviLase laser systems is intended for use in the electromagnetic environment specified below. The 
costumer or the user of LaserShot M and NaviLase laser systems should assure that it is used in such an environment

NOTE 1 At 80 MHZ and 800 MHz, the higher frequency range applies.
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by
absorption and reflection from structures, objects and people.

2 Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land
mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with
accuracy. To assess the electromagnetic environment due to fixed transmitters, an electromagnetic site survey should
be considered. If the measured field strength in the location in which the LaserShot M and NaviLase laser systems
incubator is used exceeds the applicable RF compliance level above, the LaserShot M and NaviLase laser systems
incubator should be observed to verify normal operation. If abnormal performance is observed, additional measures
may be necessary, such as reorienting or relocating the incubator.
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
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symbol glossary
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Part I: Introduction
This chapter provides an outline of the key features and applications of the 
LaserShot M/NaviLase system 

 Introduction

The laser systems for microsurgery utilized in the field of assisted reproductive technology 
(ART). The laser systems can be used to manipulate the zona pellucida of oocytes or 
embryos in order to assist hatching and to extract polar bodies or cells for subsequent 
genetic analysis.

Key Features of the LaserShot M / NaviLase System 

The LaserShot M / NaviLase system is based on an infrared laser diode emitting at a 
wavelength of 1,48 µm which is coupled to an inverted microscope. The laser beam is 
directed along the microscope optical axis. The spatial arrangement of lenses and mirrors 
within the laser unit allows focusing of the laser beam to the image plane of the microscope 
objective. In addition to LaserShot M, NaviLase includes motion elements which allow the 
controlled movement of the laser beam to any position within the working field which is 
visible from the camera image. The microscope should be equipped with a heating stage 
to ensure optimal conditions for oocytes, zygotes and spermatozoa. The infrared 1,48 µm 
wavelength emitted by the laser diode is non-mutagenic and thus, it is ideally suited for the 
use in non-contact procedures in ART. 

Working with LaserShot M/ NaviLase and EyeWare

The LaserShot M / NaviLase system provides an advanced laser technology for ART 
featuring digital control and digital video / image processing combined with high optical and 
electro-mechanical quality. Controlled by the EyeWare imaging software the LaserShot M / 
NaviLase system can be intuitively used for the daily routine. 

Acquired by a high resolution digital camera a live video stream of the cells is displayed at 
the computer monitor. The video image is overlaid by an computer generated crosshair, 
which marks the aiming position of the laser beam. A laser pulse is triggered either by 
mouse or optionally by foot switch. The irradiation time of the laser is set within the user 
interface of the EyeWare software. 

With EyeWare not only microscopic devices, microscopic imaging and measurements 
can easily be managed, but also documentation has been made very convenient. With the 
database module patient data and snapshots are stored and administrated. Connection to 
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an external database allows importing and exporting of datasets. A predefined report with 
any set of examination results can be printed after only a few mouse clicks. Datasets may be 
exported to PDF-files for e-mail forwarding and to RTF-files or to CSV-files for further text or 
spreadsheet program processing, respectively. 

Focusing of the zona pellucida at equator level and 
positioning of the oocyte or embryo

Laser activation

Selection of laser working 
mode (NaviLase only)

Adjustment of pulse time / hole diameter

Triggering the laser

Manipulation of the zona pellucida

Select laser lens

Working Principle



18 User Manual Laser Systems version 7.3

Manipulation of the Zona Pellucida 
using LaserShot M / NaviLase 

The laser beam generated by the LaserShot 
M / NaviLase causes a tangential thinning or 
opening of the zona pellucida of oocytes and 
embryos by a highly localized photo thermal 
process which lyses the glycoprotein matrix.

Thereby, trench-like openings with even walls 
are generated (Fig. 1) which appear circularly 
shaped in a two-dimensional view. The size of 
the opening can be adapted to the respective 
procedure simply by varying the irradiation 
time of the laser. The reproducibility of the 
drilling effect is very high.

The LaserShot M / NaviLase system uses a 
laser that has no known potential mutagenicity 
as compared to, e. g. UV laser procedures. 
Furthermore, with the laser having a relatively 
low power in focus (100 mW - 250 mW) 
fundamental safety studies have been 
conducted. Until now no adverse effect of 
the described laser procedures has been 
documented. A follow-up study on 134 
children born after laser assisted hatching 
(LAH) was performed and revealed no 
increase in the major congenital malformation 
rate, no increase in chromosomal aberrations 
and no difference in the minor congenital 
malformation rate.

A

B

Photos courtesy CHUV, Lausanne, Switzerland

Fig. 1: Scanning electron micrographs of a laser 
treated murine zygote at low magnification (A) and 
at higher magnification (B).

Inform the patient about contraindications and side effects of laser 
applications (see p. 3).
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Alternatively, the outer layers of the zona pellucida may be ablated largely and across a wider 
area, but without breaching it. This process is commonly referred to as zona thinning. An 
area of 25-40% of the circumference of the zona pellucida should be thinned by contiguous 
laser shots generating holes of 15–20 μm in diameter with maximum 50% overlap. The 
overlapping laser shots should be positioned in a way to ablate about 50-70% of the initial 
zona pellucida thickness.

Note: AH is not recommended for routine use in all ART patients.

Pictures: University of Bonn

Assisted hatching (AH)

The aim of AH is to locally weaken the zona pellucida by creating a trench along the optical 
axis of the laser beam (see. Fig. 1, p.17) which appears as a hole when seen through an 
inverted microscope. 

To minimize the risk of damage to blastomeres, users should administer as few laser pulses 
as possible at the shortest pulse lengths possible to achieve zona drilling or thinning effects. 
Only a single opening should be made in the zona pellucida. Multiple openings or those that 
are too small might prevent the embryo from hatching or lead to abnormal development. The 
laser beam should be directed towards a section of the zona pellucida where the adjacent 
perivitelline space is widest. 

For AH, the drilled hole size should be approximately 1.5 times of the thickness of the zona 
pellucida. A minimal invasive strategy is to create an opening by means of 2 holes with a 
diameter of 20 µm, i.e. slightly larger than the zona thickness (typically 16-18 µm in human 
embryos). An overlap of approximately 50% will generate the desired hole size resulting in 
the formation of an oval shaped opening. (see figure C below.) Due to the 50% overlap, this 
approach is robust with respect to small variations in the actual zona thickness. 

 Application notes for LaserShot M and NaviLase
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Blastomere biopsy (cleavage stage)

The aim of cleavage stage biopsy is to retrieve 1 or 2 blastomeres from a day three embryo 
for genetic analysis.
A pulse time should be selected to create an opening of about 20 µm. The embryo should 
be rotated and blastomere(s) selected for biopsy should be positioned using a holding 
capillary. The embryo should be held close to the bottom of the dish to maximize laser 
efficiency.

An oval shaped opening should be drilled using two or three overlapping laser pulses to 
open the zona pellucida for easy access of the single blastomere selected for biopsy. If two 
blastomeres were selected for biopsy, the opening should be made in between the two 
cells. 

Trophectoderm (TE) cell biopsy

The aim of TE biopsy is to retrieve 2-10 TE cells as samples for genetic analysis. TE cells are 
separated from a blastocyst stage embryo without causing damage to the inner cell mass 
(ICM).

15 to 20 hours prior to biopsy, AH is performed making a small hole or channel (approx. 5 
μm wide) in the zona pellucida of the embryo using 1-3 laser pulses. The opening should 
be placed at the opposite side of the ICM. Typically, 5-7 TE cells will have formed a hernia, 
protruding from the hole, at the time point of biopsy. This step is optional but will facilitate 
the biopsy procedure.

Under the inverted microscope, a holding pipette is used to position and firmly fix the 
blastocyst in a way that the herniating TE cells are facing the biopsy pipette. The blastocyst 
should be hold close to the bottom of the dish to maximize laser efficiency. The biopsy 
pipette should have an inner diameter of 20-30 μm. 

The laser should be switched to TE mode.

For biopsy, 2-10 of the herniated TE cells should be aspirated into the biopsy pipette. 
Subsequently, the aspirated TE cells should be gently pulled away from the blastocyst to 
stretch and expose the intracellular junctions and minimize cell damage. Subsequently, two 
or three laser pulses are applied to the intracellular junctions of the cells to be separated. 
Pulling gently will completely break the intracellular junctions and the separated cells should 
be aspirated into the biopsy capillary carefully. They are finally placed at some distance from 
the embryo for subsequent transfer into a tube for genetic analysis.

TE MODE: RESTRICTIONS IN USE

The TE mode must only be used by experienced users trained in 
doing trophectoderm biopsies. The laser puls(es) can assist the 
release of mechanically stretched intracellular bonds between 
trophectoderm cells for biopsy. The TE mode must never be applied 
to the zona pellucida.
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DAILY ROUTINE

For maximal confidence, we recommend to confirm positioning and 
aiming of the crosshair and the correct opening size of the drilling on 
a daily basis before treating any patient embryo (please refer to the 
section Getting started or Quick Guide).

TECHNICAL SUPPORT

If you need assistance at any time, please contact Technical Service. 
For contact details please refer to the section Customer Service.

  

If cells are to be biopsied from cryopreserved blastocysts, laser application should be 
performed after thawing, as soon as the ICM can be located and before the blastocyst has 
fully re-expanded. A hole of 15-20 µm should be created opposite from the ICM. Thawed 
blastocysts will have TE cells herniating out of the zona pellucida after 2 to 3 hours of 
re-expansion.

Blastocyst collapsing
Blastocyst collapsing is a common procedure to remove the fluid inside the blastocoel in 
order to improve the efficiency of cryo-protectants and increase the survival rate during 
vitrification and warming. The laser should be positioned to target the junction between 
two TE cells that are located well away from the ICM. The blastocyst collapse should be 
induced by applying one (and only one) single laser pulse of 0.5 -1.5 ms. It is not necessary 
to breach the zona for successful collapsing. Full collapse of the TE layer may take up to 10 
minutes after applying the laser pulse. Occasionally, an embryo will not collapse even after 
time back in the incubator, but it will collapse during the vitrification procedure. 
Collapsing may be performed on full, expanded, hatching and completely hatched 
blastocysts.

Sperm viability testing
When performing ICSI it is important to use viable sperm. However, in semen samples 
containing only immotile spermatozoa it is difficult to assess which sperm are viable or not. 
In such cases viability can be tested using the Octax laser. After a laser pulse has been fired 
at the end of the sperm tail, the tail will start curling or shrinking if the sperm is viable and 
can be used for micro injection.

1. Use the laser lens.
2. Collect a few immotile sperm with normal morphology and flexible tail (they should be free
     of debris).
3. Line up the collected sperm to be able to work in an economic way.
4. Apply 1-2 laser shots to the end of the tail of each sperm.
5. If the end of the tail starts curling or shrinking (= osmotic reaction to the opening of the
     plasma membrane) the sperm is viable and can be used for microinjection.

Useful hints:
It may take 5-10 s until the response to the laser pulse(s) becomes visible. 
The laser pulse length needed for sperm viability testing may vary, depending on the 
individual microscope setup. Test for the appropriate pulse length, start with times around 
2-4 ms.
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The recipient end user of the device should not install the device upon receipt. Unpacking, 
installation, setup and end-user training of LaserShot M / NaviLase systems must be 
carried out by appropriately qualified technical staff authorized by Vitrolife GmbH.

 Setting up LaserShot M / NaviLase

EYE SAFETY OF THE OPERATOR 

Eye safety of the operator is guaranteed under normal operation of 
the LaserShot M / NaviLase, and in a situation when user removable 
parts may be missing. However, do not disassemble or uninstall the 
LaserShot M / NaviLase system. Any installation/ deinstallation of 
hard- and software, respectively, is strictly reserved to trained and 
certified service personnel authorized by Vitrolife GmbH.

INTEGRITY OF THE ELECTRO-OPTICAL SYSTEM

Maintenance of microscope components, wrong handling of the 
microscope or strong displacement of the electro-optical system, 
e. g. by mechanical shock can result in an incorrect position of the 
beam splitter system, the magnifier lens, the camera, and the turret, 
respectlively. As a result of any of the above, aiming of the laser may 
no longer correspond to the crosshair position displayed at the video 
image and damage to embryos may occur if the laser is used in this 
condition. 

LASER

The laser of the LaserShot M / NaviLase system is classified as a 
class 1M laser. Class 1M lasers emit in the wavelength range from 
302,5 nm to 4000 nm and are safe under normal operation, but may 
be hazardous if the user employs optics within the beam.

TECHNICAL SUPPORT

If you need assistance at any time, please contact Technical Service. 
For contact details please refer to the section Customer Service.

  
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Figure 2 shows the LaserShot M / NaviLase system mounted to an inverted "Olympus" 
microscope, consisting of:

• the NaviLase Motion Module (NaviLase only)
• the Laser Module
• the Mirror block
• the Laser Lens
• the Eye USB 2.0 camera

 System Components

Fig. 2: Laser system components mounted onto an inverted microscope. Motion Module exclusively for NaviLase.
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Inverted microscopes have to have a CE declaration according to  IVD 98/79/EC as a 
minimum requirement. The following inverted microscopes are approved to be used with 
laser systems (this list raises no claim for completeness):

 Manufacturer		  Model			   Type

Olympus Corporation	 IX 51			   S8F-3			 
		  IX 53			   P1F
		  IX 71			   S8F-3, S1F-3
		  IX 73			   P1F, P2F
		  IX 81			   F-3
		  IX 83			   P1ZF, P2ZF

Leica Microsystems		  DMI 3000		  B and with fluorescence light path
		  DMI 4000		  B and with fluorescence light path
		  DMI 6000		  B and with fluorescence light path
		  DMi8			   with fluorescence light path

Nikon Corporation		  Ti			   S, U, E
		  TE-2000		  S, U, E
		  Ti2			   A, E

Carl Zeiss Microimaging	 Axio Observer		  A1, D1, Z1
		  Axio Observer		  3, 5, 7
		  Axiovert		  200

Inverted Microscopes that do not comply at least with IVD 98/79/EC or MDD 93/42/EWG 
are not approved to be used with the MDR 2017/745 versions of Laser systems

The LaserShot M and NaviLase can be supplied in different set-ups also covering the 
following accessories

Product name					     REF

Target Pointer for laser systems				    19310/4150
Breadboard for installating laser systems to 		  19310/0141
Olympus IX53/73/83
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A scheme of the complete LaserShot M / NaviLase system including the computer running 
the EyeWare software for visualizing the image from the Eye USB 2.0 digital camera and 
controlling the NaviLase by its motion control elements is depicted in below.

Fig. 3: Diagram of the complete LaserShot M / NaviLase system including computer, Eye USB USB 2.0 digital 
camera, Laser Lens and LaserShot M / NaviLase components Figure does not show installation package.

CONNECTORS 

Do not disconnect the USB cable connector unless instructed to do 
so by qualified support personnel.

CONNECTION TO EXTERNAL EQUIPMENT

To guarantee basic safety and compliance with elevant EC standard 
(i.e. EN 60601-1  - Part 1 for medical electrical equipment) and 
essential performance, this equipment must only be connected to 
computer equipment certified by Vitrolife, and connection must only 
be made using certified cables.

One EyeWare license running on a dedicated PC is intended to 
control one laser system.
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The Laser Systems

The schematic illustration in Figure 3 depicts the optical path of the visible light (green line) 
and the optical path of the LaserShot M / NaviLase laser beam (red line). Emitted from the 
laser module the beam can get diverted on demand by the NaviLase motion module. At the 
beam splitter located below the nosepiece the laser light is deflected from a horizontal to a 
vertical orientation and focused to the culture dish by the laser lens. Thus, the laser beam 
points perpendicularly upwards. The visible illumination light path proceeds perpendicularly 
downwards. After passing through the beam splitter of the laser, the visible light is diverted 
and intersected into two paths by microscope optics. Some part of the visible light gets 
directed towards the camera port whereas the remaining part of the light points towards 
the eyepiece. This design ensures the safe use of the laser even when looking through the 
eyepieces (blue line) whilst a laser pulse is released.

Fig. 4: Schematic view of an inverted microscope equipped with the LaserShot M / NaviLase system

EYE SAFETY OF THE OPERATOR 

Eye safety of the operator is guaranteed under normal operation of 
the LaserShot M / NaviLase, and in a situation when user removable 
parts may be missing. However, do not disassemble or uninstall the 
LaserShot M / NaviLase system. Any installation / deinstallation of hard 
- and software, respectively, is strictly reserved to trained and certified 
service personnel authorized by Vitrolife GmbH.
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LED USB connector

On the laser module two status indicator LEDs and an USB connector are located, as 
shown in Figure 4. The status indicator LEDs provide information about the status of the 
device in addition to any messages/warnings displayed by EyeWare when controlling the 
LaserShot M / NaviLase system. The significance of the status indicator LEDs is as follows:

•• (flashing) device USB initialization (during computer boot sequence, after device plugin)

•• laser powered up, laser in standby position

•• laser in unlocked position after activation through EyeWare

Fig. 5: laser module with detailed view of status LEDs and USB connector 

LED

For normal operation, the status indicator LEDs do not provide 
any additional information. Please communicate the status of 
these LEDs when contacting Technical Support in case you are 
suspecting a problem with your LaserShot M / NaviLase system.
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Part II: Working with LaserShot 
M / NaviLase
This chapter provides basic information about operation and control of the 
LaserShot M and NaviLase device in conjunction with the EyeWare software. 

The EyeWare software provides the user interface for targeting, controlling and activating 
laser pulses in LaserShot M and NaviLase system in combination with an Eye USB2 
high-resolution camera. Software applications also cover image acquisition and storage, 
measurements and documentation. EyeWare is a SQL server based multi-purpose imaging 
and archival software, which uses encryption for saved patient data.

 Control of the Laser by EyeWare Software

CYBERSECURITY

For protection against unauthorized access to the PC running 
EyeWare use a secure Windows password with a minimum length 
of 12 characters containing capital, small letters, numbers and 
special characters.

For protection against unauthorized changes do not use an 
administrator account to run the Eyeware software.
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Installation Requirements

For proper operation of the EyeWare software, a computer system complying with the 
following minimum specifications is required:

• INTEL i5 or i7 CPU

• Intel Chipset (this is a must)

• 4 GB RAM minimum	

• 500 GB hard disk minimum 

• 6 USB 2.0 ports minimum

• Operating System Windows 10, 32 or 64 bit

• TFT screen with full HD resolution (1920x1080)

System Components

EyeWare software comes on a DVD or USB flash drive and only operates in conjunction 
with a corresponding USB dongle (Fig. 7).

Fig. 7: EyeWare software DVD and USB dongle

The EyeWare software provides the user interface for targeting, controlling and activating 
laser pulses. In the following sections, many different aspects of EyeWare are described 
with special focus on features which are relevant for laser control, image capture and 
processing.
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Setting up EyeWare Software

As an integral part of the LaserShot M / NaviLase system, EyeWare software has to be 
installed in combination with the hardware of LaserShot M / NaviLase system itself.

Calibration setup

Calibration of objectives and the intermediate 
magnification is done during the setup of 
the laser system. Verification or modification 
of the pre-set calibration can be done at 
any time. Any modification of the calibration 
settings require restart of EyeWare. 

Open the “calibration setup” dialogue at the 
FILE menu and select brand of microscope 
at first.

Specify whether or not the microscope 
is equipped with magnifier. If there is a 
magnifier define the magnification ratio.

The recipient end user of the LaserShot M / NaviLase systems 
should not unpack and install it upon receipt. Unpacking, 
installation, setup and end-user training of LaserShot M / 
NaviLase systems must be carried out by appropriately qualified 
technical staff authorised by Vitrolife GmbH. 

Fig. 8: EyeWare calibration setup 
dialogue

Fig. 9: EyeWare calibration setup 
dialogue
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Specify manufacturer of the lens and its 
magnification for each individual nose head 
position. For any nose head position not 
hosting any lens uncheck the box "in use". 
After definition of all 6 positions is done, 
confirm the settings and restart EyeWare in 
order to apply the new settings.

Fig. 10: EyeWare calibration setup 
dialogue

Main concept and workflow

The main concept of EyeWare is the transfer of data between different sections of the 
software. A typical workflow consists of the following steps:

1. Activate the live video display by accessing the Video page. 

2. Find the target object at the live video display by adjusting the microscope. 

3. Take a Snapshot by pressing the <F10> key. This automatically saves images to Quick 
File.

4. In order to select for the images which should be permanently stored, navigate to the 
Quick File page. 

5. Double-clicking to the selected image opens the Image page. 

6. Add some Measurements. 

7. Return to the Video page. When changing the page, the Storage Wizard prompts to save 
data to the database. Complete the wizard in order to save data; then the Video page is 
displayed again.

Return to step 1 and repeat as often as necessary.

8. Finally, navigate to the Database page select patient and examination, switch to the 
Report page, preview and print the examination report.

In order to recall previously saved information, navigate to the Database page or to the 
Quick File Page.

All aspects highlighted are explained in more detail in the following. 
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Menu Bar

The main menu of EyeWare is structured according to Windows standard, containing:

1. The File Menu: Navigate to Open / Save Image, Print, Change Report Template, Export, 
Send as Email Attachment, and Program Settings dialogs.

2. The Edit Menu: Contains standard Windows functions including Cut / Copy / Paste / 
Delete operations. Additionally, Insert Measure can be selected. 

3. The View Menu: Activate / deactivate the display of Standard and Data Toolbars and 
Status Bar. 

4. The Measure Menu: Navigate between Type of Measure Line and the Measurement 
Customisation dialog.

5. The Video Menu: This Menu is active when the Video page is in use. It allows navigating 
between Snapshots, Quick Snapshots, Full Screen display mode, video sources and 
Camera Setup. 

6. The Device Menu: This menu allows managing the LaserShot M / NaviLase device or 
additional devices connected. 

7. The Data Menu allows navigation and editing. Within the Database and Quick File 
page this function allows navigation in, and editing of the active category and images, 
respectively.

8. The Help Menu: Provides Information about the current version of EyeWare installed and 
allows generating and transmitting Support Request Data. 

Structure of EyeWare

The EyeWare software consists of several program sections each appearing as separate 
pages at the EyeWare main window. See Figure 11 for the different elements of the main 
window (menu bar, main toolbar, pages and status bar).

Menu bar
Main Toolbar

Status bar

Pages

Fig. 11: Elements of the EyeWare main window
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Main Toolbar

The main toolbar contains the most important commands, such as image file management, 
video snapshot and the standard clipboard buttons.

Pages

The software is organized into six pages, representing areas of the program. By changing 
between pages, certain actions are triggered. 

1. The Database page: Management of data, containing patient data and examination 
records. 

2. The Quick File page: Image storage for transient use in an image gallery. 

3. The Image page: Processing of individual images including measurements and 
measurement labels. Any changes can be saved to the Database, the Quick File or export as 
Bitmap or JPEG file. 

4. The Compare Images page: Possibility to compare up to 4 images

5. The Video page: Live video display, control of supported devices such as LaserShot M / 
NaviLase, optical calibration settings, and image gallery

6. The Report page: Preview of examination report, print report or save to PDF .

Status Bar

The status bar shows useful information about the status of the program, including the 
current video camera resolution, refresh rate, the number of measurements performed, 
current calibration and database information. 

Video Page with Laser Targeting Feature

On the Video page, EyeWare displays a live video stream acquired by the Eye USB2.0 
digital video camera. Depending on the use of the laser either in the classical ‘static’ 
mode or in the dynamic ‘moveable’ mode, two different appearances of the graphical user 
interface are available: the classical ‘Windows’-like view and the full screen view. 

The classical view of the Video page acts as a control interface for the LaserShot M system 
and the static mode of the NaviLase system. For laser targeting, control and activation, 
the Video page has to be opened. Figure 12 illustrates the essential elements of the Video 
page, including the Laser Toolbar and the Crosshair.

The Video page provides the basis for snapshots from the live video display. The status 
bar provides information about the camera resolution, the amount of images captured per 
second (fps) and the current calibration settings.
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Appearance of the Crosshair

The video image can be overlaid by a Crosshair which indicates the target area of the laser 
beam. A combination of up to two crosshairs and three circles can be selected. The circles 
represent diameters of 10 µm to 40 µm of the microscopic image shown on the monitor. 
In order to activate or change the appearance of the Crosshair, select Video – Overlay – 
Crosshair. The preferred appearance can be selected from the drop-down menu (Fig. 13). 

Hole Size Predictor

The laser Hole Size Predictor is displayed as a green circle which is part of the electronic 
target overlay. The circle diameter of Hole Size Predictor serves as a convenient means 
of reliably indicating the expected hole size in correlation to the selected pulse time. It 
interactively changes its diameter depending on the pulse time selected (Fig. 13). Vice 
versa the Hole Size Predictor allows adjusting the pulse time in accordance to the required 
hole size. 

Fig. 12: EyeWare Video page with Laser Toolbar and 
laser targeting Crosshair

Fig. 13: Selection of the Crosshair mode at the Video pagewindow

Laser Toolbar

Crosshair, Hole 
Size Predictor & 
Measurement rings

Calibration of the Hole Size Predictor

After installation of the laser system or after introducing changes to the current microscope 
setup (e.g. heated microscope stage), the Hole Size Predictor has to be calibrated to 
reliably predict the hole size for the current microscope setup. The calibration procedure 
is based on the actual diameter of a hole which was drilled at defined settings (see in bold 
below). 

The diameter of the Hole Size Predictor can be calibrated in a range between -70% and 
+200% in steps of 5% relative to the current value (Fig. 14).

Follow the steps below to calibrate the diameter of the Hole Size Predictor:

1. Select the live video page, full-screen mode (F11), in the EyeWare software.

2. Place a warmed dish (37°C / 98,6°F) containing a cell which will not be used for any    
further treatment on the heated microscope stage, e.g. an oocyte which failed to fertilize. 
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Fig. 14: Calibration of the Hole Size Predictor at the Video page

The cell should be positioned at the bottom of the dish.

3. Locate the cell through the laser lens and focus on the zona pellucida.

4. Unlock the laser, using the corresponding software button.

5. Select “Hole” as working mode from the menu if using NaviLase.

6. Using the computer mouse and “drag & drop”, direct the circle indicating the laser target 
to an area on the zona pellucida (NaviLase). 

7. When using LaserShot M, align the zona pellucida with the laser target using the cross 
moving table of the microscope.

8. Using the ms scale, adjust the laser pulse length in a way that the diameter of the circle 
indicating the position and diameter of the laser holes corresponds to the zona pellucida 
thickness.

9. Release the laser by clicking the button or by pressing the footswitch while avoiding any 
vibrations of the microscope.

10. Observe the diameter of the drilled hole: if overlapping with the green circle of the Hole 
size predictor, no further action is needed. 

11. In case the diameter of the drilled hole does not match with the diameter of the green 
circle, procede with the next step for calibration:

12. Select Video - Overlay – Calibrate Hole Size Predictor  from the menu and adjust 
the indicated hole size by clicking the arrows on the right side to overlap with the actual 
diameter of the drilled hole (Fig. 14).

13. Click ok to save the change.

14. To verify calibration, drill a new hole in another area of the zona pellucida and observe 
the diameter of the drilled hole and green circle.

The Hole Size Predictor is now calibrated to predict the diameter of drilled holes according 
to the selected pulse lengths (at 37°C / 98.6°F, laser lens, zona at the bottom of the dish, 
current microscope setup).
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Fig. 15: Control of Crosshair position

INFLUENCE OF Z-POSITION OF THE OOCYTE/EMBRYO ON 
DRILL OPENING SIZE

Inappropriate Z-positioning will result in smaller drill holes and in 
reduced laser beam quality. It is recommended to keep the cell 
near the bottom of the culture dish during laser treatment.

Alignment of the Crosshair

In order to match the position of the 
Crosshair with the center of drilled hole, 
select Video - Overlay – Customize from 
the menu and correct the position of the 
crosshair in XY-orientation by scrolling the 
sliders.

Alternatively, one slider may be highlighted 
by clicking and the Crosshair may be moved 
to the proper position by use of the cursors 
of the keyboard. This allows for a more 
precise control (Fig. 15). Another possibility 
to position the electronic target would be 
to move it to its exact position by keeping 
the <CTRL> key pressed whilst dragging it 
with the mouse.

Please note that the electronic Crosshairs 
can only be repositioned as long as the 
laser stays in its home position (NaviLase 
only).
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Fig. 16: Laser Properties dialog (Laser 
properties data shown are exemplary)

The Video toolbar provides the elements of the user interface for controlling the 
laser Pressing the Key button turns the laser into active mode.

The Video Toolbar

Information about the status of the laser is displayed in the Laser Properties 
dialog (Fig. 16), which can be activated by clicking the icon. The information is 
useful in case of contacting Technical Support. 

Clicking the Laser release button triggers a laser pulse. Alternatively the laser 
can be triggered by pressing the laser release button of the computer mouse or 
optionally by an external foot switch. 

The homing function for NaviLase resets the position of the movable laser 
beam to the home position of the fixed laser. LaserShot M is invariably in home 
position.

The laser is secured by a timeout after 600 s of inactivity of operation and will 
switch automatically to an inactive mode.

The laser irradiation time can be adjusted with the slider. Additionally, both arrow 
icons next to the slider are available to increase or decrease the duration time 
in steps of 0,5 ms. A more precise adjustment of the laser duration time can be 
accomplished by using the arrow keys of the computer keyboard.

The current laser irradiation time is displayed in green color. 

Whilst displaying a live video stream, pressing the video capture icon starts 
recording of a video sequence. There is no limitation in number and length of 
video files by EyeWare software. Extended length of video capture (hours) may 
cause problems with saving and is not intended. After finishing the sequence by 
clicking the stop button the software starts the storage wizard. Video files will be 
saved and can be recalled from the Database page in the section Video clips. 
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Triggering the Laser 

After switching the laser into active mode and selecting the irradiation time, LaserShot M 
/ NaviLase can be triggered by clicking           ,  by pressing the laser release button of the 
computer mouse or optionally with an external foot switch.

Taking Snapshots 

A snapshot of the live video image can be taken by clicking the camera button at the main 
toolbar, in the Video menu or by pressing the <F9> key. This will automatically open the 
Image page. Now some Measurements can be added. For saving the image select the   
button or return to the Video page. When changing page, the Storage Wizard prompts to 
save image data to the database.

Taking a snapshot of the life video image without interrupting the video display is 
accomplished by pressing the <F10> key. The snapshot image will be stored to the Quick 
File from where it can be saved to the database by clicking the batch transfer button 

Taking snapshots

Using the <F9> key Using the <F10> key

automatically opens the 
Image page, from where 
images can be saved to 

the database.

does not interrupt the live 
video display. The snapshot 
is stored to the Quick File 

from where it can be saved 
to the database at any time
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Calibration side bar

For quick recalling a pre-defined calibration set due to changing the objective or 
intermediate magnification, select the corresponding button within the left sidebar of the 
EyeWare window (Fig. 17). 

Fig. 17: Display of calibration settings for objectives, for the intermediate 
magnification, and the camera mode within the left sidebar

Calibration settings 
for intermediate 
magnification

Calibration settings 
for objectives 

Camera Mode
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Active calibration settings are displayed by a colored button corresponding with the color 
code of the lens. Likewise, the camera settings in use are indicated by an active button 
within the left sidebar and displayed at the status bar.

Note: The calibration values are saved with each image, both in the Database and in the 
Quick File. Each time an image is recalled from either location, there will be a notification to 
restore the calibration setting that is compatible with the recalled image (Fig.18). 

When switching back to the live video stream, the calibration settings which are indicated on 
the left sidebar become active again.

Fig. 18: Confirm dialog box

The recipient end user of the LaserShot M /NaviLase systems 
should not unpack and install it upon receipt. Unpacking, 
installation, setup and end-user training of LaserShot M systems 
must be carried out by appropriately qualified technical staff 
authorised by Vitrolife GmbH. 
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Image gallery sidebar

Any image being taken by using the quick snapshot function by pressing the <F10> key 
will be displayed in the right sidebar on the Video image page (Fig. 19). The image gallery 
sidebar provides instant display and easy navigation between acquired images which have 
been stored to Quick File. 

Fig. 19: Video page with image gallery sidebar

The Full Screen Mode: LaserShot M and dynamic operation of NaviLase

The dynamic features of NaviLase are only available in the full screen mode of the EyeWare 
(Fig. 20). Also LaserShot M can be controlled here. The full screen mode can be accessed 
by pressing the <F11> key. Pressing the <F11> key again allows returning to the classical 
view for the operation of NaviLase in the static mode.

The left sidebar of the full screen view contains control elements for taking snapshots and 
capturing videos. By activating the button "Arm laser" all relevant elements for the control 
of the LaserShot M or dynamic NaviLase laser function can be accessed ,i.e. adjusting the 
pulse time, selecting the working mode of the laser (NaviLase only), and triggering the (first) 
laser pulse(s). 

All control elements for the camera mode and the appropriate calibration settings for the 
objective and intermediate calibration in use are located within the left sidebar.

Fig. 20: Full screen mode for NaviLase dynamic operation

Image gallery 
of snapshots 
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Taking Snapshots

Snapshot images acquired by either clicking the "Snapshot" button or by pressing the 
<F10> key are displayed within the image gallery. Individual Snapshot images within the 
gallery can be enlarged by moving the mouse cursor across the image of interest (Fig. 21).

Arm Laser

Clicking to   		  activates the LaserShot M or NaviLase laser and provides access to 
the respective control elements. 

Clicking "Start"   	          initiates the laser action

NaviLase control elements for dynamic operation                     
(not available for LaserShot M)

All control elements required for the dynamic operation of 
NaviLase (Fig. 22) can be accessed after activating the "Arm 
laser" field. 

As a first step, the laser working mode has to be selected. 
Moving the mouse cursor across the field ‘Hole’ activates a 
drop down menu. Available working modes are the positioning 
of a hole, of a straight line or of a curved line to anywhere within 
the working area.

Fig. 21: Full screen mode with image gallery sidebar zoom function

Fig. 22: Selection 
of laser dynamic 
working modes
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Hole (NaviLase dynamic operation)

After selecting "Hole" as the designated operation mode, the electronic laser target gets 
activated. It indicates the current position of the laser impact and the expected hole size, 
depending of the selected pulse time. By using the drag & drop function of the mouse the 
electronic target can be moved to the intended position within the working field (Fig. 23). 
Adjustment of the expected hole size can be done by modifying the “Pulse time” either by 
moving the slider, clicking to the arrows or turning the mouse wheel.

Clicking "Start" 	        initiates the laser action and converts this field into an 
emergency stop                          button which may be used stall the laser action at any time.

Fig. 23: NaviLase operational mode for drilling single holes at a position of choice

PVS (PERIVITELLINE SPACE) MAX. RULE

For maximum safety and minimal invasive reasons, 
always select the spot to perform the laser drilling 
where the distance between cell membrane and zona 
pellucida is the largest
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Hatching (NaviLase dynamic operation)

The "Hatching" mode offers the possibility to apply a defined number of laser pulses along a 
straight line. It is ideal for drilling small openings, either for assisted hatching or for biopsies

After selecting "Hatching" as the designated operation mode, the electronic laser target 
gets activated. It shows the current position of the laser impact (indicated by a red dot in 
the center) and the expected hole size including a short line. By dragging & dropping the 
red starting spot of the line the electronic target line can be moved to the intended position 
within the working field (Fig. 24). The length of the line is defined by the distance between 
the blue starting and the yellow stopping spot. The distance can be adjusted by dragging 
each of the spots to their confining positions. Adjustment of the expected hole size can 
be done by modifying the “Pulse time” either by moving the respective slider, clicking to 
the arrows or turning the mouse wheel. The number of pulses per line is limited to 60. A 
maximum overlap of 50% between adjacent circles is allowed.

Clicking "Start" 	       initiates the laser action and converts this field into an emergency 
stop button 		  which may be used stall the laser action at any time.

Zona thinning (NaviLase dynamic operation)

The "Zona thinning" mode offers the possibility to apply a defined number of laser pulses 
along a curved line. 

After selecting "Zona thinning" as the designated operation mode, the electronic laser 
target gets activated. It shows the current position of the laser impact (indicated by a 
red dot in the center) and the expected hole size including a curved line. By dragging & 
dropping the blue starting spot of the line the electronic target line can be moved to the 
intended position within the working field (Fig. 25). The length of the line is defined by the 
distance between the starting and the yellow stopping spot. The distance can be adjusted 
by dragging each of the spots to their confining positions. The radius of the curved line 
can be adjusted to the perimeter of the zona pellucida by moving the pink spot to the 
appropriate position. Adjustment of the expected hole size can be done by modifying the 
"Pulse time" either by moving the respective slider or by clicking to the arrows.

Fig. 24: NaviLase operational mode for drilling holes along a predefined straight line
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The degree of overlapping between adjacent circles and hence the shape of the line 
produced by the laser can be determined by adjusting the number of pulses whilst keeping 
the pulse time (the hole size) at a defined value (Fig. 26). The number of pulses per curve is 
limited to 60. A maximum overlap of 50% between adjacent circles is allowed.

Fig. 25: NaviLase  operational mode for drilling holes along a predefined 
curved line

Fig. 26: NaviLase operational mode for drilling holes along a predefined 
curved line with high degree of overlapping of individual shots

Clicking "Start" 	        initiates the laser action and converts this field into an 
emergency stop button 		       which may be used stall the laser action at any time.
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TE mode (NaviLase dynamic operation)

The "TE" (trophectoderm) mode offers the possibility to apply a preselected number 
of one to three laser pulses along a straight, vertical line. It is used to support a trained 
operator during trophectoderm biopsy for the step of releasing intracellular bonds between 
mechanically streched trophectoderm cells. 

TE MODE: RESTRICTIONS IN USE 

The TE mode must only be used by experienced users trained in 
doing trophectoderm biopsies. The laser puls(es) can assist the 
release of mechanically streched intracellular bonds between 
trophectoderm cells for biopsy. The TE mode must never be 
applied to the zona pellucida.

After selecting "TE mode" as the designated operation mode, the electronic laser target 
gets activated. It shows the current position of the laser impact (indicated by a red dot in the 
center) and a line along which the preselected number of shots will be applied.	

The number of shots applied in TE mode can be pre-selected in the classical view of 
EyeWare as shown in Fig. 27. From the menu select Device -> NaviLase ->-TE mode to 
select 1, 2, or 3 shots.

Fig. 27: NaviLase  preselection of laser pulses in TE mode
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For operation in full screen mode, the electronic target line can be moved to the intended 
position within the working field by dragging & dropping the red starting spot of the line 
(Fig. 28). Adjustment of the laser impact can be done by modifying the "Pulse time" either 
by moving the respective slider, clicking to the arrows or turning the mouse wheel.

Clicking "Start" 	        initiates the laser action and converts this field into an 
emergency stop button 		       which may be used stall the laser action at any time.

Fig. 28: NaviLase target line in TE mode (see arrow).

TE mode using LaserShot M
The "TE" (trophectoderm) mode offers the possibility to apply a preselected number of one to 
three laser pulses along a straight, vertical line. It is used to support a trained operator during 
trophectoderm biopsy for the step of releasing intracellular bonds between mechanically streched 
trophectoderm cells.

TE MODE: RESTRICTIONS IN USE
The TE mode must only be used by experienced users trained in doing 
trophectoderm biopsies. The laser pulse can assist the release of 
mechanically stretched intracellular bonds between trophectoderm cells for 
biopsy. The TE mode must never be applied to the zona pellucida.

To select the TE mode in the classical view of EyeWare:
Select Device -> Laser -> Trophectoderm mode from the menu
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REPEATED LASER SHOTS

Repeated Laser shots to the same position of the embryo could 
result in an increased risk of embryo damage. In case of risk of 
applying repeated Laser shots to the same position of the embryo 
the laser action can be immediately stalled by pressing the 
emergency stop button.

After selecting "Trophectoderm mode" as the designated operation mode, the display of laser 
pulse length changes from green to red color. This is to indicate that TE mode is active and the last 
pulse length used in TE mode has been saved and is displayed. The Hole Size Predictor (circle) is 
inactivated automatically. The laser target is indicated by a crosshair.

Use the laser to support in TE biopsy as recommended in Indications for Use (pp. 19)
After finishing TE cell treatment, switch back to hatching/blastomere biopsy mode:
Select Device -> Laser -> Hatching, Biopsy from the menu.

Alternatively, the laser is reset to hatching mode automatically after switching the laser off and on 
again using the key symbol from the laser tool bar.

Check that the display of laser pulse length is displayed in green color to indicate hatching mode. 
The last pulse length used in hatching mode has been saved is displayed. The Hole Size Predictor 
is reactivated automatically.
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Quick File Page for Rapid and Temporary Storage of Images

The Quick File provides a clipboard-like storage of images without associated 
measurements. It can be useful for quickly saving an image without following the complete 
procedure of the Storage Wizard. For recalling an image from Quick File and displaying it 
at the Image page, e.g. for reviewing measurements or saving to a file or to the database, 
highlight the desired image and double-click it. 

There is no limitation in number of images saved to Quick File. However, a large number 
of images makes it more difficult to identify a specific one. When using the Quick File, it is 
recommended to empty the Quick File gallery after completing the storage of all images 
which are intended to be saved (Fig. 29) at the end of the day.

Fig. 29: Quick File page



50 User Manual Laser Systems version 7.3

The Quick File Toolbar

The Quick File toolbar mainly includes the functions similar to the functions of the Database 
toolbar. For information regarding a specific button move the mouse cursor over any button 
to get a short description of its function or consult the chapter Database Page. Additional 
functions are:

Delete Function

For deleting selected items of the Quick File click on the trash can icon. Keep the [shift] and/
or [CTRL] key pressed and select all desired images. 

Batch Transfer to the Database

Using the database batch transfer button, more than one image can be transferred to the 
database at the same time with the Storage Wizard. More than one image can be selected 
by keeping the [shift] or [Ctrl] key pressed and highlight all desired images. After the transfer 
of all selected images to the database has been completed, a dialog box prompts to select 
whether or not stored images should be deleted from Quick File.

Compare Images Page

The Compare Images page provides the possibility 
to display and compare up to four selected images. 
In order to transfer images to the Compare Images 
page, select images from Quick File by right-
clicking and assign the corresponding position this 
particular image is thought to have on the Compare 
images page (Positions A,B, C, or D) (Fig. 30). 
EyeWare does not evaluate the images selected for 
comparison.

Image Page with Measurement Feature

The Image page is mainly used to assign 
measurements to newly acquired snapshots 

(Fig.31 ). Additionally, existing images can be 
loaded from either the database (double click to the 
respective image at the Database page) or from files 
(select File > Open Image) and displayed. Changes 
can be saved either to the database by the use 
of the Storage Wizard (select         or change 
page) or to file (selecting File > Save Image). The 
measurement function allows the determination 
of the cell diameter, the hole diameter and the 
thickness of the zona pellucida.

Fig. 30: Compare Images page

Fig. 31: Image page with measurements 
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Measurement Toolbar

For information regarding a specific button move the mouse cursor over any button to get a 
short description of its function.

Measurement Function  

By using the measurement function new measurements can be applied. In order to 
determine the size of an object, click to the position where the line should start and hold the 
mouse button down until the end point is reached. The length of the drawn line is displayed 
in µm. The measurement function can either be activated by clicking the measurement 
button   or by pressing the <Ins> key.

After selecting the drawn measurement line by clicking, it can be edited with different 
operations, like cut / copy / paste / delete, resizing, moving etc. The type of measurement 
can be modified from the Measure menu.

Calibration of EyeWare is required for carrying out measurements. Calibration depends on 
the microscope set-up and is set at "calibration setup…". Please make sure to select the 
proper calibration settings before applying any measurements. 

Apply changes to the database 

Clicking            saves any modifications to the database, which then are displayed at the 
measurement category of the database page.

Clicking                cancels changes and reverts the image to the last version stored.

Navigation 

Using the arrows allows scrolling through the gallery of images of a patient in a selected 
examination or through the gallery of images at the Quick File page, depending on the 
location from which the image has been accessed.
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Type of Measure Line

The type of measure line can be modified in the 
Measure menu. Either a predefined label (cell 
diameter, cell total diameter, hole diameter, zona 
pellucida thickness) can be selected (Fig. 32) or 
a new type of measure can be created using the 
measure customization dialog. 

Measure Customisation Dialog

A new Measurement application can be created and a list of defined measurements can be 
set up (Fig. 33). 

A new Measurement application is created by clicking New App, then the measurements 
are defined as follows:

• its name - for the printed report

• its short label - for the measure lines displayed on the image

• its long label - for the display in the menu

If a measurement is identified with diameter "TRUE" the program will calculate area and 
volume, assuming the object is spherical. Adding the "&"-character to the long label allows 
creating keyboard shortcuts, by defining the character following the “&” as the shortcut 
key. For example: &Cell Diameter will define "C" as shortcut in the measure menu (Cell 
Diameter).

The copy (Ctrl C) and paste (Ctrl V) short-cuts can be used to copy the  Ø - symbol.

Fig. 32: Defining the type of measure in the 
Measure Menu

Fig. 33: Measure customisation dialog, measure application setup
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Measure Line

For the individual appearance of the measure lines their color, arrow color, arrow fill color, 
shadows and text font can be configured (Fig. 34).

Fig. 34: Measure customisation dialog, measure line properties

Storage Wizard for Associating Images with Patients

For simplifying the process of storing a new image to the database of EyeWare, the Storage 
Wizard guides through the steps necessary to save an image. Please note every image 
intended to be kept has to be saved to the database.

1. Deciding where to save the image

It can be chosen between storing the image temporarily to Quick File or associating the 
image with a patient, respectively. 

In case an image is supposed to be associated with a patient data set either choose New 
patient to generate a new patient data set (please proceed to step 2), or select an Existing 
patient from the list. In case of a large patient population, use the search function, by  
clicking          . Now search for ID, Last Name, First Name, Birthday or Code (proceed to step 
3).

Fig. 35: dialog saving images
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2. Adding a new patient

When adding a new patient file, the database allows entering a limited amount of information 
about the patient.

• Last Name 

• First Name 

• Birthday 

• Code

For the field ‘Code’ either the ID number of the main patient tracking database or any 
other unique identifier can be chosen. Patient data (last and first names, birthday) will be 
encrypted upon saving to the database and is protected against reading without using the 
EyeWare database function for cybersecurity reasons.

3. Selecting the examination

With each image of a patient, an examination is associated. The examinations are used to 
organize the images of the respective patient. One patient can have different examinations 
and one examination can contain different images.

For a new examination, choose New Examination. Otherwise, select an existing examination 
and directly proceed to step 5. Whenever saving an image to a new patient, no examinations 
will initially exist. Therefore, a new examination needs to be added according to step 4.

Fig. 36: dialog saving images
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4. Adding a new examination

An examination is mainly determined by the date at which it is carried out. In addition, the 
name of the examiner and the examining lab can be added in order to keep track of all 
relevant examination data. 

Fig. 37: dialog saving images

5. Finish

An examination is mainly determined by the date at which it is carried out. In addition, the 
name of the examiner and the examining lab can be added in order to keep track of all 
relevant examination data. 

Fig. 38: dialog saving images



56 User Manual Laser Systems version 7.3

The Database Page for Managing Data Sets

The Database page allows recalling and managing data sets, based on patient data and 
examination records. Navigation through patient data sets and examination data sets can be 
accomplished by using the respective navigation bar for each of the sections. (Fig. 39).

The database of EyeWare is structured for routine medical use. For this intent a patient list 
is at the root of the database. For each patient the respective examinations are assigned. 
Each examination may contain one or more images or videos associated with one or more 
measurements (Fig. 40). 

When a snapshot is saved to the database by use of the Storage Wizard, it is associated 
with both patient and examination data. The wizard also allows the entry of new patient/
examination data.

In some circumstances, as in a non-patient related operation, it may be desirable to shortcut 
the Storage Wizard and to quickly save the image to Quick File. Please note that when 
using Quick File, no measurements are saved. 

For recalling an image from the Database page and loading it to the Image page (e.g. for 
reviewing measures or saving to a file), double-click any image of the active examination. 

With every image stored a comment may be associated. Click           to open the multiline 
editor. The software automatically timestamps every image at the time point of saving it to 
the database.

Fig. 39: Structure of the database

Fig. 40: Database page
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The DatabaseToolbar

For information regarding a specific button move the mouse cursor over any button to get a 
short description of its function:

Data Navigation

Clicking the arrows allows scrolling through the highlighted category or directly getting to 
the first or last object.

Insert / Delete Function

The active object may be inserted or deleted.

Data Revision (edit, post, cancel, refresh) 

After selection of a category a specific dataset can be edited. Subsequently, modifications 
can either be accepted or deleted. Clicking the refresh button will update the dataset.

Search Function

The search function offers the selection of different search criteria depending on the 
active category denoted by a bold title (Patient         , Examinations          , Images or   
Measurements          ). 

First the search category has to be selected by clicking to the respective icon. Then the 
search term to be looked for has to be entered. Clicking         will start the search (Fig. 41).

The icon for the search function is also shown in the Storage Wizard at step 1 and 
3. Search function at step 1 corresponds with "Find in [patient]", step 3 with "Find in 
[examination]".

Fig. 41: Database search function
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Report Page for Printing Examination Results

EyeWare allows to quickly printing out any set of examination results. The available report 
layouts are predefined. On the Report page, a preview of the examination report selected in 
the Database page is displayed below. This report will be printed as shown in the preview 
when the print command is issued after confirming the Print Dialog.  

Available Report Layouts

Four different pre-designed reports are available. For changing the type of report layout you 
may select the desired page design at File - Report - Template from the menu.

Export of reports

The report may be exported as PDF, RTF, DOCX or HTML file. The address shown in the 
upper right of the report can be customized through File > Settings > User Data.
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The Report Page Toolbar

For information regarding a specific button move the mouse cursor over any button to get a 
short description of its function.

Navigation Function 

In case of a multipage report, navigation is possible by use of the arrow buttons. 

Zoom Function

Zooms the preview to display the whole page, to 100% or to maximal width respectively. 

Full Screen  

Displays the report at full screen mode. At the upper most position of the screen, the report 
toolbar is shown upon moving the mouse to this area, allowing navigating between pages. 
To switch to normal view, press the <ESC> key or click on the door symbol in the toolbar. 

TECHNICAL SUPPORT

If you need assistance at any time, please contact Technical Service. For contact 
details please refer to the section Customer Service.

  
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Prior to the first use of the LaserShot M or NaviLase system or 

• each time the whole microscope setup has been moved

• if the LaserShot M / NaviLase system was not used for a period of time

• after microscope maintenance

• after other major events, which could have induced movements and strong vibrations to 
the whole microscope and laser system

The position of the laser impact should be confirmed and the laser irradiation time should be 
determined to ensure safe treatment of oocytes and embryos.

Starting EyeWare Software

Start the EyeWare software by double clicking the icon item on the computer desktop. 
Confirm the message and in order to initialize the live video display, select Video page.

Laser Aiming Verification Procedure

Take a cell which will not be used for any further treatment, e.g. an oocyte which failed 
to fertilize. The cell doesn’t need to be intact, except for its zona pellucida. Starting the 
EyeWare software and selecting the Video page initiates the live video screen. Activate 
the laser by clicking        . Select a cell and switch to the dedicated laser optics. The laser 
impact area is located in the center of the field of view and is indicated by a crosshair. (In 
case the crosshair modus is inactive or in order to change the design of the electronic 
target, select Video – Overlay – Crosshair and the preferred design in the menu.) Move 
the zona pellucida of the spare cell into the crosshair area and trigger a single laser pulse 
by clicking         , pressing the laser release button of the computer mouse, or optionally by 
using an external foot trigger. 

The Crosshair on the screen should be located straight at the center of the opening to be 
created by the laser (Fig. 42). If this is not the case, the position of the crosshair has to be 
moved to the exact position within the laser drilled opening.

 Getting Started

Fig. 42: Properly aligned electronic laser target
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INTEGRITY OF THE ELECTRO-OPTICAL SYSTEM

Wrong handling of the microscope or strong displacement of the 
electro-optical system, e. g. by mechanical shock can result in an 
incorrect position of the beam splitter system, magnifier lens position, 
camera, and the turret position, respectlively. As a result of any of the 
above, aiming of the laser may no longer correspond to the crosshair 
position displayed at the video image and damage to embryos may 
occur if the laser is used in this condition. 

INCORRECT LASER AIMING

Failure to follow the laser aiming verification procedure could result 
in wrongly located openings and therefore may damage the treated 
oocyte or embryo. 

REPEATED LASER SHOTS 

Repeated laser shots to the same position of the embryo could result 
in an increased risk of embryo damage. In case of risk of applying 
repeated laser shots to the same position of the embryo the laser 
action can be immediately stalled by pressing the emergency stop 
button.

In order to match the position of the crosshair with the center of drilled hole, select 
Video - Overlay – Customize from the menu and correct the position of the crosshair in 
XY-orientation by scrolling the sliders.

After checking / aligning the crosshair in NaviLase home position, verify target position also 
in NaviLase dynamic mode as follows: position the spare cell in a corner of the NaviLase 
working area, move the laser target to the zona and trigger a single laser pulse. Verify 
position of the target indicator. It should be at the center of the drilled opening. If this was 
not the case, document deviation by taking a snapshot. Repeat above steps after moving 
the spare cell to the remaining three corners one after the other.

		  Caution: In case that the target indicator did not match with the center of 	
		  the drilled opening in one or more cases, stop using NaviLase in dynamic 	
		  mode. Contact 	customer service and provide the snapshots of the 		
		  deviation(s). Only use NaviLase in verified home position until the error will 	
		  be fixed.
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Relationship between irradiation time and opening size

According to the drilling strategy, a single laser pulse must generate a hole of appropriate 
size. The relationship between laser irradiation time and opening size is influenced by 
various factors such as the type of microscope, the kind of heated microscope stage (glass 
or metal), the type of heating system, the temperature, the culture dish, the culture medium, 
and finally the thickness, type and hardness of the zona pellucida. 

The sole controllable parameter determining the opening size is the laser irradiation time. 
The laser energy is a function of the laser power and the irradiation time. Since the laser 
power is fixed, variation of the laser irradiation time will adjust the total laser energy, by 
which a drilled hole is introduced into the zona pellucida, 

Due to the variability between laser irradiation time and the obtained drill hole size, the 
appropriate irradiation time for creating a hole of defined size cannot be precisely predicted 
or transferred from one laboratory to another. Instead, it has to be determined by a brief 
experiment on a spare cell for each individual microscope setup. This procedure finally 
results in a reliable electronic hole size indication displayed by the LaserShot M / NaviLase 
Hole Size Predictor . 

How to determine the “default pulse length setting” and verify the calibration 
of the Hole Size Predictor

The electronic overlay (green circle) of the Hole Size Predictor interactively indicates the 
expected opening diameter when selecting or changing a laser pulse length. Before starting 
to use the laser, verify the calibration of the Hole Size Predictor by following the steps 
below. Doing so, you can make yourself familiar with the “default pulse length setting” on 
your microscope. That is the pulse length which will generate an opening diameter of zona 
pellucida thickness (e.g. as will be used for assisted hatching or zona thinning):

1. Select the live video page, full-screen mode (F11), in the EyeWare software

2. Place a warmed dish (37°C / 98,6°F) containing a cell which will not be used for any 
further treatment on the heated microscope stage, e.g. an oocyte which failed to fertilize. 
The cell should be located at the bottom of the dish.

3. Locate the cell through the laser lens and focus on the zona pellucida.

4. Unlock the laser, using the corresponding software button.

5. Select “Hole” as working mode from the menu if using NaviLase.

6. Using the computer mouse and “drag & drop”, direct the circle indicating the laser target 
to an area on the zona pellucida (NaviLase). 

When using LaserShot M, align the zona pellucida with the laser target circle using the 
cross moving table of the microscope.

7. Using the ms scale, adjust the laser pulse length in a way that the diameter of the green 
circle indicating the position and diameter of the laser holes corresponds to the zona 
pellucida thickness.
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8. Release the laser by clicking the button or by pressing the footswitch while avoiding 
any vibrations of the microscope.

9. Verify that the diameter of the newly created hole is identical with the diameter of 
the circle indicating the position and diameter of the laser holes.

In case you observe a difference of the two diameters, re-check if all the following 
settings applied: temperature of the dish and microscope stage was 37°C / 98.6° F, 
the laser lens was used, the zona was located at the bottom of the dish.

Also read the following chapters about the influence of temperature and Z-positioning 
of the zona pellucida on the size of the drilled hole.

If the above treatment conditions were correct, see chapter Calibration of the Hole 
Size Predictor and perform a recalibration.

Important Notes on Laser Irradiation Time 

Temperature

Conforming to good laboratory practice, the microscope to which the LaserShot M 
/ NaviLase system is installed should be equipped with a heating stage that ensures 
temperature maintenance of the cells and the culture medium to 37°C during the entire 
procedure.

The relationship between irradiation time and opening size is temperature dependent. 
Choosing inappropriate temperature settings or forgetting to switch on the temperature 
controller will cause unexpected opening sizes. 

INFLUENCE OF TEMPERATURE ON DRILL OPENING SIZE 

When using a heated stage during zona manipulation, make sure 
that it has been set to the correct temperature. Inappropriate 
temperature settings will lead to unexpected drill hole sizes. 
Lower temperatures result in smaller openings, while higher 
temperatures cause openings of excessive sizes that may lead to 
embryo damage.
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Vertical (Z)-Positioning

Using a holding pipette to ensure the positioning of the embryo during laser treatment 
can be an advantage, but also introduces an additional parameter that needs the user’s 
attention. For optimal results, the vertical (Z)-position of the holding pipette should always 
be as such, that the cell remains near the bottom of the culture dish during laser drilling.

The correlation between irradiation time and opening size is dependent on the vertical 
position (Z-direction) of the cell in relation to the bottom of the culture dish. Increasing 
the distance between the cell and the bottom of the culture dish will lead to increased 
absorption of the laser energy by the culture medium. Hence, wrong Z-positioning will  
result in unexpected opening sizes.

INFLUENCE OF Z-POSITION OF THE OOCYTE/EMBRYO ON 
DRILL OPENING SIZE

Inappropriate Z-positioning will result in smaller drill holes and in 
reduced laser beam quality. It is recommended to keep the cell near 
the bottom of the culture dish during laser treatment.
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Variation of the Laser Drilling Position and Strength

After strong displacement of the whole electro-optical system, e.g. a mechanical shock, 
the quality of the drilled hole has to be checked when using the parameters which had 
been adjusted previously (irradiation time and aiming of the laser). The laser drilled holes 
and openings will be of good quality if the laser impact is located near the center of the live 
video image on the monitor. This position may deviate slightly from the center of the monitor 
screen depending on the monitor used and combination of lenses. 

Closing Eyeware Software

Close the EyeWare software by selecting File > Exit from the main menu or by clicking 

INTEGRITY OF THE ELECTRO-OPTICAL SYSTEM

Wrong handling of the microscope or strong displacement of the 
electro-optical system, e. g. by mechanical shock can result in an 
incorrect position of the beam splitter system, magnifier lens position, 
camera, and the turret position, respectlively. As a result of any of the 
above, aiming of the laser may no longer correspond to the crosshair 
position displayed at the video image and damage to embryos may 
occur if the laser is used in this condition. 

DOUBTS ABOUT THE SUITABILITY OF THE LASER

In case of doubt about the suitability of the laser to create good 
quality openings do not continue to use the laser as there may be an 
increased risk of embryo damage. Please have your system checked by 
authorized support personnel or contact Technical Service. For contact 
details please refer to the section Customer Service.
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Part III: Additional 
Information
Advanced Functions of EyeWare, Advanced Database Functions, Program 
Settings and Camera Settings are listed in this chapter. Furthermore information 
about Maintenance, Troubleshooting and Customer Service is provided.

Open Image and Save Image Dialog 

EyeWare allows import of images and saving images to file. Supported file formats are 
Windows Bitmap files (*.bmp) and JPEG (*.jpg or *.jpeg). The Open Image and Save Image 
dialogs (Fig. 43, 44) are standard Windows functions.

Open Image 
A preview of the selected image is displayed in the Open Image dialog. A zoomed preview 
can be displayed by clicking the magnifier icon.

 Advanced Image Handling Functions

Fig. 43: dialog opening images
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Save Image 
Click and highlight an image at the Database or Quick File page and select Save Image.

Save with Measurements
Images to which measurements have been added can be stored together with the measure 
lines from the Image page.

Print 
For printing a report from EyeWare, the printer must be chosen first. Be sure you have a 
printer installed and configured for this feature to function properly. Contact your system 
administrator if necessary.

The Print Dialog (Fig. 45) is a standard Windows dialog. For more information, refer to the 
Windows Help feature.

Fig. 44: Open Image and Save Image Dialog

Fig. 45: Print Dialog

Photo Print
For printing a snapshot from the image page select Photo printing. For this function it is 
recommended to use a photo printer.



68 User Manual Laser Systems version 7.3

Send Image as e-mail Attachment
EyeWare automatically launches the e-mail program, composes a new mail and attaches the 
selected image file (the computer running EyeWare needs to support Microsoft Outlook®).

Fig. 46: Sending an image as an e-mail attachment

PLEASE NOTE

Your email software has to be properly configured to send and receive e-mails on 
this computer.


 Program Settings

Several aspects of EyeWare are customizable. This allows the user to adapt some functions 
of the software according to specific needs. The Program Settings dialog allows modifying 
the following functions:

User Data
In this area, the end user contact 
information can be entered. There are up to 
6 lines to be filled in with information such 
as name and address, telephone numbers, 
e-mail address etc. (Fig. 47). 

Several language options are available.

Fig. 47: Program Settings Dialog 
for User data entry
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Mouse
This dialog allows configuring the properties 
of the computer mouse. While mouse pointer 
is located at the Test Area any click of one of 
the mouse buttons will reveal which mouse 
button corresponds to which button number. 
Tick the checkbox to select the mouse button 
that triggers the laser pulse. Additionally, a 
mouse button for taking a quick snapshot can 
be selected (Fig. 48).

Furthermore, a key from the keyboard can be 
selected to trigger the laser.

The footswitch for triggering the laser has to 
be activated using the shot key function F12.

Fig. 48: Program Settings Dialog for mouse properties

Backup all Settings to REG-file 
All settings of EyeWare can be saved to a backup file in the EyeWare system folder. 
Automatically, a file name is generated containing the computer name, date and time of 
storage (Fig. 49). 

In order to restore previous settings, select the appropriate file from Windows Explorer, 
double click and confirm the entry of the stored information into the registry. Now your 
previous settings are restored, including the settings of this dialog, and can be checked in 
the Program Settings dialog. 

Fig. 49: Program settings are stored to the EyeWare system folder 
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 Camera Settings

The NaviLase system comes with an Eye USB2.0 camera. Exemplary, Fig. 50A, B show 
the camera properties of an Eye USB2.0 camera (1280x1024, 15 Hz). Usually, exposure, 
gamma and white balance should be set to automatic, whereas brightness and contrast can 
be adjusted manually.

Fig. 50A: Camera Properties dialog of an Eye USB2.0 camera

Fig. 50B: Camera Properties dialog of an Eye USB2.0 camera
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 Generating Support Request Data

EyeWare facilitates technical support. Open the menu Help and click Info… and then click 
Support Request (Fig. 51) and select the information that should be included to the support 
request. Alternatively use default settings. Always enter senders address details and s short 
description of the problem (Fig. 52). Then decide how to send the file. 

• Send as e-mail (the computer running EyeWare needs to support Microsoft Outlook®): 
EyeWare automatically launches the e-mail program, composes a new mail and attaches the 
zipped support files. Finally complete and send the email. 

Fig. 51: Support Request Fig. 52: Support Request Options 

Vitrolife

• Save to file: Select where to save the System Data and wait until data are copied. Attach 
the file to an e-mail or send a disk with the System Data to Vitrolife GmbH. For contact 
details please refer to the technical service section.

• HTTP upload: The System Data are automatically uploaded to server via Internet 
connection. Some comments about the problem may be added before uploading the data. 
Please inform your local distributor or Vitrolife GmbH about further details.

PLEASE NOTE

Without any administrator rights some of the system data are not 
available for enclosure to the support request file. For including these 
data please contact your system administrator if applicable.
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Lasers and their components are not in contact with human oocytes or embryos when 
applied according to the intended use and will not be contaminated during treatment when 
used according to the instructions for use. Contamination can only occur in terms of slight 
dust accumulation through ambient air or accidental contamination of the laser lens with 
media or oil for embryo culture. The lasers can therefore be considered as non-critical 
devices with respect to reprocessing. Point-of-use processing after every treatment as well 
as high level cleaning, disinfection, or sterilization procedures are not required. Cleaning and 
low level disinfection can be handled in one step as described below.

	 Never remove any of the laser components from the microscope for 		
	 cleaning! Never change their position or orientation or apply pressure!

	 Never spray any of the laser components with disinfectants or any other 	
	 cleaning agent! Never use abrasive cleaning agents!

Clean the surfaces of the laser components whenever dust has accumulated. Cleaning 
of optical components outside the preventive maintenance intervals is only required after 
accidental contamination of the laser lens with media or oil for embryo culture or after 
exceptional dust deposition. If done according to the instructions below, cleaning and 
disinfection (regardless of its frequency) will not impact the lifetime of the lasers.

 Cleaning and Disinfection

The LaserShot M system exhibits superior mechanical and optical precision, which makes 
realignment unnecessary during routine use. 

LaserShot M and NaviLase are maintenance free systems. For the static LaserShot M there 
are no parts to be replaced in specific intervals or movable parts prone to disturbances. 
For the motion modules of NaviLase a preventive replacement after five years of use is 
mandatory.

A preventative maintenance of the laser is recommended every 12-18 months to ensure 
optimal performance of the laser.

System updates will be provided within short response times by technical staff of Vitrolife 
GmbH, Germany. For contact details please refer to Customer Service. 

Make sure not to touch any optical components, i.e. the mirror block and the laser objective 
lens, respectively.

 Maintenance
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1. Cleaning and disinfection of metal and plastic surfaces of LaserShot M and NaviLase 
components. Moisten a lint-free cleaning tissue with a non-volatile, quaternary ammonium 
based disinfectant, ready to use for cell culture environment. The tissue should be slightly 
dampened, not wet. Wipe the surfaces of the laser components and let the disinfectant dry.

2. Cleaning and disinfection of optical components of LaserShot M and NaviLase (front 
lens of the 25 x laser objective, dichroic mirror): Clean only if the laser lens has been 
contaminated with oil or media for embryo culture, use a lint-free tissue or lens cleaning 
paper to absorb any visible liquid first. Subsequently, moisten a lint-free tissue or lens 
cleaning paper with small volumes of 70 % isopropyl alcohol. Make sure cleaning is done 
at the end of the working day, in well ventilated environment and when all embryo culture 
dishes are stored in incubators in order to avoid exposure of embryos to isopropyl. The 
cleaning tissue should be disposed outside the IVF laboratory. Carefully wipe the front lens 
of the laser objective or the dichroic mirror. Do not touch with your fingers nor apply too 
much pressure. The mirror should only be wiped unidirectional.
Let the cleaning agent dry off and visually inspect the optical surfaces for the absence of any 
remaining contaminants or traces of dried cleaning agent.



74 User Manual Laser Systems version 7.3

 Troubleshooting Guide

In case some technical problems occur during operation of LaserShot M/ NaviLase please 
check possible causes of defects according to the list below before contacting the technical 
support.

Problem

Misalignment
Misalignment in "home" or 
"target pointer" position: 
crosshair on the screen is not 
located straight in the center   
of the opening you created 

Misalignment in other locations
crosshair on the screen is not 
located straight in the center of 
the opening you created

Possible Cause

• whole setup has been moved
• LaserShot M / NaviLase was                     
not used for some time
• microscope maintenance
• major events which could 
have introduced movements 
and strong vibrations to the 
microscope and laser system

Golden laser objective is not in 
correct position

1,5x/1,6x magnifier is not in 
correct position

Light path selector lever is not 
in correct position

Camera or c-mount is loose

Recommendation

1. Restart EyeWare, 
2. Check the laser alignment 
in “home” or “target pointer” 
position
3. Correct overlay settings

a. ensure objective is correct 
and right in place (clamped)

b. Additional magnification is 
off (1x) and is clamped

c. Beam splitter is in correct 
position and clamped

d. Camera is tightly fixed (do 
not move it, only check)

4. If the problem persists and 
misalignment is below 2 cm on 
the screen, move the overlay as 
described in the section Laser 
Aiming Verification Procedure 

1. Restart EyeWare

2. Check the alignment in 
“home” or “target pointer” 
position 

3. If the problem persists, 
contact Technical Support
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unexpectedly small drilling 
sizes
drilled opening is suddenly 
smaller as intended

drilled openings are gradually 
getting smaller while irradiation 
time remains constant

Crosshair not displayed or 
unexpected appearance of 
crosshair

Laser cannot be activated
(key icon or “Arm laser”)

NaviLase does not move 

glass stage yes/no
culture media in use

excessive z-position

temperature too low

PolarAIDE slider (not included 
in laser system) placed in the 
beam path (depending on type 
of microscope and position of 
the PolarAIDE slider)

optics of the laser are getting 
dusty

• crosshair modus is inactive
• appearance of crosshair has 
been modified

Laser not initialized correctly

laser irradiation time has to be 
adjusted as described in the 
section Laser irradiation time 
determination for appropriately 
sized openings

for optimal results, the vertical 
(Z)-position of the holding 
pipette should always be such 
that the cell remains near the 
bottom of the culture dish 
during laser drilling.

increase temperature of culture 
cells and medium to 37°C

Pull PolarAIDE slider out of the 
light beam path

call the technical service 

select video – overlay – 
crosshair and the preferred 
design from the menu.

Check LEDs on golden laser 
module.
If red:
1. close EyeWare
2. �disconnect USB cable from 

laser module
3. reconnect after 5 s
4. restart EyeWare

Check LEDs on NaviLase 
controller box.
If red:
1. close EyeWare
2. �disconnect silver USB cable 

and black “5V” cable from 
controller box

3. reconnect both after 5 s
4. restart EyeWare
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 Decommissioning of LaserShot M / NaviLase

 Customer Service

For decommissioning of the LaserShot M / NaviLase system please send back to Vitrolife. 
For contact details please refer to the section Customer Service below.

TECHNICAL SUPPORT

If you need assistance at any time, please contact Vitrolife Technical Services.   

Vitrolife GmbH 

Roedersteinstrasse 6

84034 Landshut / Germany

phone: + 49 (0)871 4306570

email:	 support.de@vitrolife.com
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Part IV: Quick Guide
The Quick Guide outlines in a tight and concise manner important and frequent 
operations.

 Laser Aiming Verification Procedure

Start the EyeWare by double clicking icon on your desktop, read and confirm the message 
and select Video page.

• Activate the laser by clicking.

• Move the zona pellucida of the spare cell into the Crosshair area.

• Trigger the laser pulse.

• The Crosshair on the screen should be located straight in the center of the opening 
introduced into the zona pellucida (52A). If this is not the case (52B), the position of the 
Crosshair has to be moved to the exact position within the laser drilled opening. 

Fig. 52A / B: Cross Hair positioning

A B



78 User Manual Laser Systems version 7.3

If required: correct the position of the crosshair in XY-orientation. Therefore select Video - 
Overlay – Customize from the menu (Fig. 53A) and scroll the sliders. Alternatively, click and 
highlight one slider and move the crosshair with the cursors of the keyboard into position. 
This allows more precise control (Fig. 53B)

The laser Hole Size Predictor is a convenient means of reliably indicating the expected hole 
size in correlation to the selected pulse time. Displayed as a green circle which is part of the 
electronic target overlay, it interactively changes its diameter depending on the pulse time 
selected. Vice versa the Hole Size Predictor allows adjusting the pulse time in accordance 
to the required hole size 

In order to calibrate the diameter of the Hole Size Predictor based on the actual diameter of 
a drilled hole at a defined pulse time, select Video - Overlay – Calibrate Hole Size Predictor 
from the menu and adjust the indicated hole size by clicking the arrows on the right side 
(Fig. 54). The diameter of the Hole Size Predictor can be calibrated in a range between 
-70% and +200% in steps of 5% relative to the current value.

Fig. 54: Hole Size Predictor  Adjustment

 Hole Size Predictor Adjustment
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Every time the EyeWare is started, an automatic initial positioning of the NaviLase motors is 
performed. A forced repositioning can be performed by using the NaviLase Reset function.
It may be used after longer time of pausing the laser while EyeWare was running.
Click on Device -> NaviLase -> Reset to start the process.

Every time the EyeWare is started, an automatic initial positioning 
of the NaviLase motors is performed. A forced repositioning can be 
performed by using the NaviLase Reset function.
It may be used after longer time of pausing the laser while EyeWare 
was running.

 NaviLase Reset 	
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 Working Principle LaserShot M - NaviLase

Open the Video page

LaserShot M / NaviLase 
Static mode

Activate laser

Trigger laser pulse

Take a Snapshot

Adjust pulse time according to 
the indicated hole size

Focus to zona pellucida at equator level 
and position oocyte or embryo

<F10>

Open full screen view

NaviLase 
Dynamic mode

Activate laser

Trigger laser pulse

Add some measurements

Store to database using the Storage Wizard

Select a patient and an examination in the Databasepage

Switch to the Report page; preview and print the examination report

Select working mode

Focus to zona pellucida at equator level 
and position oocyte or embryo

Adjust pulse time according to 
the indicated hole size

<F11>

Take a Snapshot

Insert the laser lense
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 Taking snapshots

Taking snapshots

Using the <F9> key Using the <F10> key

automatically opens 
the Image page, 

from where images 
can be saved to the 

database.

does not interrupt the 
live video display. The 

snapshot is stored to the 
Quick File from where 
it can be saved to the 
database at any time

TECHNICAL SUPPORT

If you need assistance at any time, please contact Technical Service. For contact 
details please refer to the section Customer Service.

  
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Part IV: Appendix
 The Appendix contains further documentation

 Target Pointer

The Target Pointer is an optional device for LaserShot M and NaviLase which can be used to 
localize the laser target by the position of a red LED dot when looking through the eyepieces 
of the inverted microscope. The Target Pointer also features an optical signal pattern of four 
red LED dots. This square pattern indicates the instant of releasing a laser pulse.

Key Features of the Target Pointer

The Target Pointer offers an optional indicator of the laser target in addition to the target 
overlay of the EyeWare software. Whereas the digital overlay can only be observed on the 
screen, the Target Pointer emits red LED light which is visible both on the screen as well as 
through the eye pieces of the inverted microscope. 

A static LED module consisting of five red LEDs is built into the mirror block of the laser 
system. Four LED lights are arranged in a square pattern and one LED light is at the center 
of the square pattern. The Target Pointer LED module can be adjusted manually by two 
screws (see Fig. 55). Turning the screw(s) will shift the position of the Target Pointer LEDs 
on the screen in X and/or Y directions. This way, the position of the central red LED dot 
of the Target Pointer is superimposed with the digital laser target overlay on the screen to 
indicate the laser target of LaserShot M and of NaviLase in home position.

Working with the Target Pointer

Target Pointer function is activated or deactivated in the Device menu, section Pointer. 
To activate, check On and visible; uncheck box to deactivate Target Pointer function. 
When Target Pointer function is active, the red Target Pointer LED dot will be turned on 
automatically when LaserShot M / NaviLase function is activated using the Key symbol.

	 Check that the central LED dot of the Target Pointer is superimposed 	
	 with the digital laser target overlay on the screen and verify the selected 	
	 hole size before using the Target Pointer for laser aiming.

Functional states of the Target Pointer LED lights when working with the laser (also see 
figures a-c):

a. The central LED is turned on and indicates the laser target position when the laser is 
activated. The central LED stays on as long as the laser stays activated without being 
released. 
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b. When releasing a laser pulse, simultaneously the central LED is switched off and 
the square pattern of four LED dots is turned on for a 2 seconds interval. This optical 
pattern indicates the instant of laser impact and enables for unhindered view at the 
targeting area of the laser.
 
c. Following the 2 seconds interval in b., the central LED is turned on again (now 
visible in the center of the laser induced opening).

Functional states of Target Pointer LED dots: a, c: central LED dot indicating laser target position; b: square 

pattern of four LED dots, activated for a 2 seconds interval when a laser pulse was released.

1. USB Port
2. Status LED
3. Y – adjustment (allen wrench key 1.5 mm required)
4. X – adjustment (allen wrench key 1.5 mm required)
5. Focusing of the red light dot (allen wrench key 1.5 mm required)
6. Switch

6 5 4

3

2

1

Fig. 55: Target Pointer
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Adjustment procedure

First check if dioptre is set to ZERO for both of the eyepieces (Fig. 56). Indicators are seen 
on each eye piece lens.

Then verify ase shot position matching with the cross hair on screen. If not, adjust laser 
cross hair position. See chapter "Alignment of the Crosshair". Activate laser and crosshair 
will appear. If there is mismatch between crosshair and red dot move the red dot to the 
crosshair position using the X and Y adjustment until red dot will match with the crosshair. 
Make use of the 1.5 mm wrench key. Therefore insert the tool into the small hole and turn the 
key clockwise or counter clockwise until the red dot moved to desired position. Start with 
correcting X position of the red dot (Fig. 57) and proceed with Y position (Fig. 58)

Fig. 56: Diopter adjustment (example: Olympus inverted microscopes)

Fig. 57: X position adjustment Fig. 58: Y position adjustment

Correct Y position of the red dot
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If red light beam is seen very weak or widely spread (Fig. 59) correct the focus of the beam. 
Use 1.5 mm wrench key (Fig. 61) and turn clockwise and check how the spot changes its 
appearance. If spot is getting smaller continue turning the focus screw until red dot is set 
sharp pointed. If spot spreads wider turn into opposite direction until red dot is seen sharp 
(Fig. 60).

If red LED light is not visible at all first turn off the light of the microscope or reduce to a 
minimum level of light in order to see the red light trough the eyepiece. If the red light is seen 
weak or widely spread focus the red light see chapter above.

Fig. 59: widely spread red dot

Fig. 61: Adjusting focus of red dot Target Pointer

Fig. 60: red dot focused
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If red dot is still not visible (Fig. 62) check the X and Y alignment. Focus at any specimen 
located at the bottom of the dish. Watch the spot trough eyepiece and turn the screws for 
LEFT/RIGHT and UP/DOWN slowly but steady several revolutions until red light gets back 
into the field of view.

Finally adjust red light dot to convenient brightness. 
Brightness is automatically corrected on screen but 
brightness of the beam seen through the eyepiece depends 
on user preferences. Therefore open the menu DEVICE / 
POINTER and click on CUSTOMISE. Move slider left for 
decreasing brightness and move to the right for increasing 
brightness.

Fig. 62: Target Pointer

TECHNICAL SUPPORT

If you need assistance at any time, please contact Technical 
Service. For contact details please refer to the section Customer 
Service.

  

EYE SAFETY OF THE OPERATOR 

Eye safety of the operator is guaranteed as the visible light is in 
the range of visible light.
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Laser: 		  1.48 µm Infrared Diode Laser, Class 1M. Definition of a class 	
		  1M laser according to DIN EN 60825-1:2014: Class 1M lasers 	
		  emit in the wavelength range from 302,5 nm to 4000 nm. 
Power in focus: 		  100 - 250 mW (depending on microscope, optics, heated 		
		  stage & operation mode)
Impulse time: 		  0.1 - 10.0 ms, in 0.1 ms steps (CPU Clock +/- 1,5 %)
Laser targeting: 		  live video display with crosshair and calibrated measurement 	
		  grid overlay
Video display:		  with EyeWare on computer monitor
Status indication:	 	 LED on LaserShot M module, EyeWare user interface 
Laser irradiation release: 	 via mouse or external foot trigger
Laser irradiation indication: 	 LED on laser module, EyeWare user interface 
External connectors:	 laser module is connected to computer via USB cable
Power supply: 		  via USB, NaviLase option includes PS 5V/2A
Dimensions:	  	 laser module: 11.5 x 11.5 x 9.8 cm (+/- 10%)
Operating conditions: 	 10°- +35 °C ambient temperature relative humidity 20%-80% 	
3x		  (non-condensing), 735 - 1060 hPa
Transport conditions: 	 -20° - 70°C, relative humidity 20%-80% (non condensing), 
		  735 - 1060 hPa
Storage conditions:		 -20° - 70°C, relative humidity 20%-80% (non condensing), 
		  735 - 1060 hPa
Objective: 		  25x ELWD biopsy objective for simultaneous micromanipulation 	
		  and laser use, compatible with Hofmann modulation contrast
Compatibility:		  compatible with all major brands and models of inverted 		
		  microscopes complying with at least IVD 98/79/EG
Labelling: 		  This system bears the        -mark Labelling Sample

 Laser Module Specifications / Labeling

Laser Radiation, do not view directly into light path using optical instruments
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 Order code			   Product name

19310/4150			   Target Pointer for laser systems
19310/0141			   Breadboard for installating laser systems to 		
			   Olympus IX53/73/83

 Related Products

SALES

For sales information please contact your local Vitrolife distributor or

 

Vitrolife GmbH 

Roedersteinstrasse 6

84034 Landshut/ Germany

phone:	+49 (0)871-430657-0

email: 	 support.de@vitrolife.com

  

The following Accessories are optional parts of the MDR 2017/745 versions of laser 
systems:
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D-Vitrolife GmbH
Roedersteinstrasse 6
84034 Landshut Germany
Tel: +49 871 430657-0

E-mail 
support.de@vitrolife.com

Internet
http://www.vitrolife.com  
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